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[bookmark: _Toc427829015]Audience

This document is targeted to the Lease Administrator, with instructions written in such a way that the full process should be able to be completed by someone with little prior knowledge.
Task-level instructions have been grouped into high-level sections (indicated by blue headings).  Role(s) responsible for a section is indicated in bold above the first consecutive occurrence.  Where a task is performed by someone outside of the role responsible for the section, the person/role is named outright. e.g. Faculty Finance (Accountant) updates….”

Where sections of the process are executed by other roles, instructions are written at a high-level, with the assumption being that the activities required are already known.


[bookmark: _Toc427829016]Prerequisites

· Access to KAOS via Filemaker Pro
· Science IS login to ServiceNow
· Sassafras K2 KeyServer installed and permissions granted
· Access to Alleasing Online Contract Management (OCM) portal
· Faculty Finance (Accountant) or Business Analyst (Finance) can provide/request this as required.
· Email client with mail merge capability.  Instructions have been written for:
· Mozilla Thunderbird email client with Mail Merge plugin installed
· Microsoft Outlook
· Access to the Science IS Lease Admin mailbox
· Membership to the Dell Reports mailing list (see IT Procurement to be added)
[bookmark: _Toc427829017]Timing

To allow enough time for all of the sub-process to complete, the Lease Refresh Process commences 4 months (approximately 120 days) prior to the end of the following quarter (e.g. Lease planning for Q3 returns should begin on June 1).

To make reading the overall process easier, the process has been divided into 4 sub-sections, Plan, Order, Receive and Deploy.
[bookmark: _Toc422223296]

[bookmark: _Toc427829018]Process
[bookmark: _Toc427829019]PLAN

Lease Administrator
1. [bookmark: _Prepare_Quarterly_Reports][bookmark: _Toc422223297][bookmark: _Toc427829020]Prepare Quarterly Reports

Rather than rely on an external dependency as a trigger, the Lease Refresh Process is initiated by the Lease Administrator.

Several reports are required initially: From the leasing company (as authoritative for exactly what equipment is to be returned), from KAOS (that provides more details about user, location etc so equipment can be located and replacements arranged as required), and from KeyServer (that contains more user information per asset).
These reports will be aligned using a reconciliation spreadsheet so that any discrepancies are resolved, and a single report produced containing exactly what needs to be returned, where it is located and its owner details.

There is a bit of effort required in preparing these reports, and attention to detail is crucial, but with some diligence (and potentially some lateral thinking) a final authoritative report will be produced.

Update ‘Standard Models’
The first thing we need to do is just make sure the ‘standard’ models on which we base our recommendations are up to date per University standards.

0.1. Review ‘Appendix A – Standard Hardware’ against the intranet and Cyclone sites.

0.2. Update the hardware specifications in Appendix A with any changes required.

0.3. Download ‘Lease_reconciliation_MASTER.xlsx’ from the KB.

0.4. Update the ‘Working’ tab -> Base Models section with the latest update, as well as any update to the price.

0.5. Upload both files back to the KB.

OCM Report
This report tells us what the leasing company is expecting back.

0.6. Log on to Alleasing Online Contract Management (OCM) at https://app.alleasing.com.au/ocm2/ 

0.7. Click ‘Search Assets’

0.8. Enter a comma-separated list of all of the Science Faculty Cost Centres (available in Appendix C – Cost Centres) in ‘Cost Centre’, and a range for the schedule expiry date in ‘Expiry Date From:’ and ‘Expiry Date To:’ (2 weeks on either side of the end of next quarter).
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0.9. Click ‘Search’ to get the records, and ‘Export’ and save the file locally as ‘OCM_<leasenumber>.xls’
KAOS Report
This report pulls information out of KAOS that will help us identify a computer.

0.10. Open KAOS, and click ‘Sections’ -> ‘Finance’ -> ‘Lease Schedules’
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0.11. Make a note of the lease schedule with the ‘Due Back’ date falling at the end of the next quarter.

[image: ]

0.12. Click ‘List’ -> ‘Asset’ and filter for the lease schedule number noted down earlier.

[image: ]

0.13. Clicks ‘File’ -> ‘Export Records’ and save the output locally as ‘KAOS_<leasenumber>.xlsx’.

0.14. Click ‘Continue…’ on the ‘Excel Options’ prompt that appears.
[image: ]

0.15. When prompted for the fields to include in the export select ‘Current Table (“Asset Detail”)’ in the drop-down and click ‘Move All’.
[image: ]

0.16. Select ‘CEA’ in the drop-down, for each field below, select it and click ‘>> Move >>’.
· ::CEANo
· ::CommentsForCEA
· ::CreatedBy
· ::Department
· ::OrderedFor
· ::RequestedBy

[image: ]
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etc. etc. 

To be clear, you need to repeat this instruction 5 times (move each field individually).  There appears to be a bug in FileMaker Pro v14 where you can no longer multi-select fields and move them all at once.  This has been logged with FileMaker, but until it is fixed we just need to take this manual action.



0.17. Select ‘AssetCustodian’ in the drop-down, then select the ‘::Fullname’ field from the list below and click ‘>> Move >>’.
[image: ]

0.18. Select ‘KSComputers_odbc2’ in the drop-down and click ‘Move All’.
[image: ]



0.19. Select ‘KSTermCPUType’ in the drop-down and click ‘Move All’ .
[image: ]

0.20. Select ‘OrderItem’ in the drop-down, then select the ‘::Description’ field from the list below and click ‘>> Move >>’ .
[image: ]

0.21. Then click ‘Export’.  This should return you to the main ‘Asset’ screen in KAOS with the filter you applied earlier.

Attractive Assets Report
This report pulls information regarding monitors and other ‘attractive assets’ out of KAOS.

0.22. Click ‘File’ -> ‘Export Records’ and save the output locally as ‘AttractiveAssets_<leasenumber>.xlsx’.

0.23. Click ‘Continue…’ on the ‘Excel Options’ prompt that appears.



0.24. Clear the previous export query by clicking ‘Clear All’.
[image: ]

0.25. Select ‘AssetAttractiveAssetDetail’ in the drop-down at top-left, and click ‘Move All’
[image: ]

0.26. Select ‘CEA’ in the drop-down, then select the ‘CEANo’ field from the list of fields below and click ‘>> Move >>’.

0.27. Then click Export.  This should return you to the main ‘Asset’ screen in KAOS with the filter you applied earlier.

Hardware Report
This report complements the original KAOS report, and (if present) tells us the hardware details of what Dell shipped us originally.  Particularly useful with regards hard drive size that can’t be sourced in other reports.

0.28. Click ‘File’ -> ‘Export Records’ and save the output locally as ‘Hardware_<leasenumber>.xlsx’.

0.29. Click OK on the intermediate ‘Excel Options’ prompt that appears.

0.30. Clear the previous export query by clicking ‘Clear All’.

0.31. Select ‘OrderDellAssetReports’ in the dropdown at top-left, and click ‘Move All’.
[image: ]

0.32. Click Export.

0.33. Close KAOS when the export is complete.

0.34. Open ‘Hardware_<leasenumber>.xlsx’ and place the cursor in cell A1.

0.35. In the menu ribbon at top, switch to the ‘Data’ tab.

0.36. Select Data Tools -> Remove Duplicates, and select only the ‘OrderDellAssetReports::Service Tag’ column.
[image: ]

0.37. Save Hardware.xlsx.

Users Report
The next report will get data for the most frequent users of all machines in the Science faculty.  These will be our contact points if the ‘Custodian’ isn’t completed in KAOS, and is a ‘best guess’ of primary user.

0.38. Open KeyConfigure (Sassafras K2).

0.39. Within the Computers -> Display window, right-click on ‘SC-Science’ and select ‘Logins (COMP x user)’
[image: ]

0.40. In the ‘Report Builder’ window that is displayed, select a date range covering the last 6 months.  (Example below for report run on 31/07/2015).
[image: ]

0.41. Drag and drop the following ‘Additional Columns’ to the ‘Included’ on the right:
· ‘System Serial’
· ‘Last User’
· ‘Disk Model’
[image: ]

0.42. Click ‘Run’ to run the report.
[image: ]

0.43. When the report has completed (this will take several minutes) click the ‘Total Time’ column to sort the results by total time (greatest to lowest).
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0.44. Click File -> Save As

0.45. Change the file type to .txt, ensure the ‘Include Group data on all lines’ box is checked, and save as ‘Users_<leasenumber>.txt’.
[image: ]

0.46. Open ‘Users_<leasenumber>.txt’ in Excel.

Reconciliation Spreadsheet
All of the data that we’ve just produced is now copied into several tabs within a single spreadsheet that will help us consolidate it.
When copying/pasting, be sure that ALL data is captured (including header lines) as this is important for integrity of the consolidated spreadsheet.

0.47. Download ‘Lease_reconciliation_MASTER.xlsx’ from the KB.

0.48. Save as ‘Lease_reconciliation_<leasenumber>.xlsx’ (e.g. ‘Lease_reconciliation_155.xlsx’)

0.49. Copy all data from ‘OCM_<leasenumber>.xls’ into the ‘OCM Raw’ tab of ‘Lease_reconciliation_<leasenumber>.xlsx’.
[image: ]

0.50. Copy all data from ‘KAOS_<leasenumber>.xlsx’ into the ‘KAOS Raw’ tab.
[image: ]

0.51. Copy all data from ‘AttractiveAssets_<leasenumber>.xlsx’ into the ‘AttracAssets Raw’ tab.
[image: ]

0.52. Copy all data from ‘Hardware_<leasenumber>.xlsx’ into the ‘Hardware Raw’ tab.
[image: ]

0.53. Copy all data from ‘Users_<leasenumber>.txt’ into the ‘User Raw’ tab.
[image: ]

0.54. Close all of the previous reports, leaving only ‘Lease_reconciliation_<leasenumber>.xlsx’ open.

0.54.1. Make sure you keep a copy of ‘OCM_<leasenumber>.xls’ saved locally.  You can use this for input into the Collection Receipt at the other end of the process, as it has all of the required fields.

0.55. Switch to the ‘AttractiveAssets’ tab (note NOT the ‘AttracAssets Raw’ tab), and filter the ‘Status’ column for all non-blank entries
[image: ]

0.56. Copy all rows that have been returned, and paste below the last entry in the ‘KAOS Raw’ tab

[image: ]

This gets all of the KAOS data, assets (PCs) and ‘attractive’ assets (e.g. monitors) in one place so that we can properly compare it.

0.57. Navigate to cell A1 in the ‘OCM Working’ tab and sort by Department, CEANo AND AssetDetailID.
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0.58. If prompted, accept the default option to ‘Sort anything that looks like a number, as a number’.
[image: ]

0.59. Check to see if the ‘MASTER’ tab and all sheets with red tabs have captured all of the data.  
If dealing with a large data set (e.g. a catchup of the backlog) you may need to ‘extend’ the formulas down more rows (they generally stop at ~2,000 in the master spreadsheet).

The reconciliation spreadsheet will now list the differences between the two sources, OCM and KAOS, as listed below.

Some of the differences need to be checked now (outlined in the following steps) by the Lease Administrator, while others are flagged for Department Management to review when they receive the associated quotes.

· Lease Administrator to check (detailed below):
· CEA mismatches (column AD)
· Serial mismatches (column AE)
· CPU, HDD, RAM, Graphics card (columns G-J), cells filled in bright red – Hardware details missing
· Rows highlighted orange – No contact person

· For Department Management information
· Rows highlighted grey – Machine will not be replaced (e.g. already in storage)
· Rows highlighted orange – No contact person listed, Science IS unable to locate contact
· Rows highlighted green – Listed contact didn’t respond to emails
· Rows highlighted red – Listed contact requested an exception to the standard replacement.

CEA Mismatches
0.60. Switch to the ‘MASTER’ tab and note down the CEA listed where an issue has been flagged in Column AD.
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For each CEA noted:

0.60.1. Open the CEA in KAOS and look at the scan of the ‘Acceptance Certificate’ that should be attached.
The Acceptance Certificate will clearly show the correct lease schedule to which the CEA applies.

[image: ]

0.60.2. Update the lease schedule details of the CEA in KAOS to the correct value per the Acceptance Certificate.

[image: ]

0.60.3. Click the link to the Order associated with the CEA, and update the lease schedule for the individual equipment to the correct value as well.

[image: ]

0.61. Clear any filters if they have been applied.


- Serial Number Mismatches
The spreadsheet also checks for computer serials that exist in the OCM report, but don’t exist in the export of KAOS data.
Errors flagged here are generally for Macs, but we still need to resolve each error to make sure we’re returning the expected equipment.

0.62. Switch to the ‘MASTER’ tab and note down the relevant Serials where issues have been flagged in column AE.

[image: ]



For each asset noted:

0.62.1. Open the CEA listed in the ‘CEA No’ column and check for the missing item(s) in the list of assets on the Order, and in the documentation attached to the Order.
- Typos
0.63. IF it is clear the serial has been mistyped in KAOS, update the serial number in KAOS, and also the corresponding entry in the ‘KAOS Raw’ tab.
This will clear the alert.

0.64. ELSE IF it is clear the serial has been mistyped in OCM by the Leasing Company:

0.64.1. Add a note to this effect in the ‘Notes’ field against the corresponding serial in the ‘MASTER’ tab: “Returning like for like – OCM incorrectly reports serial as <serial> so return is essentially a like for like”
[image: ]

0.64.2. Manually delete the alert in Column B as the issue has been addressed.


0.65. ELSE IF the asset exists against the Order, but the serials are quite different (i.e. the same number of items of the same specification appear on the CEA in KAOS as appear in OCM, however one (or more) serials don’t match):

0.65.1. Add the serial from KAOS to the corresponding entry in the ‘MASTER’ tab.

0.65.2. Add a note to this effect in the ‘Notes’ field against the corresponding serial.
[image: ]

0.65.3. Manually delete the alert in Column B as the issue has been addressed.

This can occur when an asset has been sent for repair during its lifecycle, and replacement provided.  By putting in both serials, the Support person deploying the replacement will know to look out for either, and we will be able to return at least an equivalent, satisfying the leasing company.

Hardware Details Missing
Specific hardware configurations are included in the data so that we can recommend replacements without having to open each CEA, and users are fully informed about what hardware they currently have so they can make an educated decision regarding their replacement.
The bulk of the data should be automatically populated, but we may just have to make some manual updates for any missing entries.

0.66. Review the ‘CPU’, ‘HDD’, ‘RAM’ and ‘Graphics’ columns for any cells filled in bright red (which indicates missing hardware details).
[image: ]

0.67. For each cell highlighted, review the associated CEA for the specific information from the attached quote/packing slip/invoice.

0.68. Manually enter the missing information into the relevant cells.

No Contact Person
Where a primary contact person is unable to be filled automatically, we need to do a little more work to see if we can find this information, or whether it needs to be left to Department Management to find.

0.69. Review any rows filled in orange.
[image: ]

0.69.1. For each highlighted row, review the ‘CEA Created By’, ‘CEA Ordered For’, ‘CEA Requested By’, ‘Notes’ and ‘Comments’ columns to see if there is any other information available as to who the machine was intended for.

0.69.2. Discuss all remaining orange rows with Team Leaders to decide whether more information is available from the resources to hand, or whether it will be passed to Department Management.

0.69.3. For any updates that are able to be made based on the above steps, manually enter the upi into the ‘Custodian’ field (email address will automatically be populated, and highlighting removed).



Add Full Names
We need to make the report slightly more readable, so that people who review it won’t need to try and translate upi’s themselves, rather we can do it for them.

0.70. Copy the ‘Custodian’ and ‘Most Frequent User’ columns
[image: ]

0.70.1. Paste the details into the ‘Multi-UPI Search Tool’: https://www.sit.auckland.ac.nz/sso/protected/support_tools/uoaMUSearch.php (can be accessed via ‘The Matrix’: https://www.sit.auckland.ac.nz/sso/protected/), and click ‘Go’.  Don’t worry about the formatting, or even the header rows getting in there as the tool sorts this out for us.
[image: ]

0.70.2. Copy the results, and paste into the ‘Working’ tab, starting at cell A26.
[image: ]

[image: ]

The ‘Contact Name’ field in the ‘MASTER’ tab will now be populated.

[bookmark: _Final_Cleanup]Final Cleanup
0.71. For any computer highlighted grey, red or orange, also highlight a corresponding monitor manually to indicate that no quote will be raised for that monitor until we can be sure of the requirements.

0.71.1. The corresponding monitor can generally be found immediately below the computer (as they are sorted this way).  If there is no monitor immediately under the computers, check the original CEA to see if there are any notes to indicate which on the list is the correct monitor.  If so, highlight the correct monitor manually.

0.71.2. If not, and there are monitors on the same CEA that aren’t immediately below a computer (i.e. haven’t been attached to a particular asset in KAOS), pick one of these monitors and highlight as above.

0.71.3. If not, and there are no unassigned monitors on the same CEA, then it is safe to assume the computer has no monitor/has a monitor on a different lease.  Proceed without any manual update

0.72. Review all entries in the ‘Notes’ column in the ‘MASTER’ tab for anything else that should be addressed and hasn’t yet been covered.

0.73. Update/flag for discussion as required.

0.74. Review the list of data for any replacements that you know are already underway (i.e. quotes/CEAs have already been raised and are being following through).

0.74.1. For any instances where this is the case, update the ‘Result’ column to ‘Replacement already underway’ (which colours the row accordingly, and removes the email address so no email is sent).

[image: ]

0.75. Review the list of Contact Names for multiple instances of the same name (which can indicate a supervisor in charge of several machines, in which case we don’t want to send them multiple emails).

0.75.1. For all instances where the Contact Name is the same, manually delete the email address on the same line, and manually highlight this row for your reference.

0.76. Do a final review of the data in the ‘MASTER’ tab as a whole for obvious issues/anomalies (e.g. computers assigned to ‘Administrator’, departed staff, invalid hardware details), or instances of multiple computers under one username (e.g. labs/pool computers) where the email address in the spreadsheet may be deleted manually.

This is an important QA step and must not be missed.

0.77. If there are any other issues that aren’t able to be resolved by the above steps, escalate to the Team Leaders for discussion and resolution.

0.78. Review the data as a whole with the Team Leaders and any relevant support staff with Department-specific knowledge to see if there are any entries that should be manually updated prior to proceeding.

Team Leaders MUST be at least informed of decisions made here.

0.79. Save ‘Lease_reconciliation_<leasenumber>.xlsx’.

0.80. Check where you are in the process (use the swimlane diagram or milestone document for reference) against the end of the lease schedule.  Are you on track?  If not, escalate to the Team Leaders to discuss.

[bookmark: _Raise_Service-Now_(SN)][bookmark: _Raise_ServiceNow_Request][bookmark: _Toc293821605][bookmark: _Toc422223298]

[bookmark: _Toc427829021]Raise ServiceNow Request per Cluster

0.81. Raise a separate ServiceNow Request per lease, per cluster/area (see Appendix C), with details below (fields not referenced to be left blank):
· Requestor:		Lease Administrator
· Prioritisation:		Low (per default)
· Assignment Group:	Science IS
· Assigned To:		Self
· Classification:		Non-Standard
· Category:		New/Install
· Subcategory:		Computer/Hardware
· Short Description:	<Cluster/area> - Lease <lease number>
· Comment:		This master ticket tracks the return for Lease <lease number> for <cluster/area>.  Return date is <lease expiry date>.  No action is required, this has been logged purely for tracking purposes.
· Watchlist:		GSM/BOM, Cluster Accountant
· Attachment:		Lease_reconciliation_<leasenumber>.xlsx

An example for reference for the SBS/Psych cluster can be found in ticket REQ0640516.

[bookmark: _Toc422223299][bookmark: _Toc427829022]Send Targeted Emails

0.82. Open ‘Lease_reconciliation_<leasenumber>.xlsx’ to the ‘MASTER’ tab.

0.83. Set the first cell in the ‘Response Date’ column (coloured white) to the date by which end users must respond.  (All other ‘Response Date’ cells will then populate based on this entry).

0.84. For all rows not coloured orange or grey, populate the ‘Proposed Replacement’ column with the equivalent model using ‘Appendix A – Standard Hardware’ as a guide.

· You can select the base configuration of each model via a dropdown list in each cell, then adjust as required.
· Apply your own knowledge of the departments to the proposed models (spec’ing down only if required), but be careful not to make assumptions.

0.85. Email Team Leaders attaching updated ‘Lease_reconciliation_<leasenumber>.xlsx’ requesting approval for all proposed replacements.

0.86. IF following discussion with Team Leaders it is decided that a user requires immediate consultation:
0.86.1. Update the ‘Result’ column for that entry to ‘Replace (exception request)’ (which colours the row accordingly)
[image: ]

0.86.2. Manually delete the entries in the ‘Contact Email’ column and ‘ProposedReplacement’.

0.86.3. Also manually highlight the row of the corresponding monitor red (indicating that no replacement monitor will be ordered until we can be sure of requirements).

0.86.4. Create a ServiceNow Work Task under the related parent Request, with the following details:
· Prioritisation:	Low (per default)
· Assignment Group:	Science IS/ITS Tamaki IT (as required)
· Assigned To:		Unassigned
· Short Description:	<Department> - Lease <lease number> - User consultation required
· Description:		The computer assigned to <Custodian> is due back on lease and appears to be a custom build.  Details below:
<copy/paste from the ‘TagNo’ column to the ‘Graphics’ column for this asset>
Please get in touch with <Custodian> directly to discuss their hardware requirements for this replacement of this machine, and add the specific details to this ticket when complete so a quote can be raised.
 
0.87. Save ‘Lease_reconciliation_<leasenumber>.xlsx’.

0.88. Then Save As in format ‘.csv (MS-DOS format)’ accepting any prompts from Excel and close the spreadsheet.

[bookmark: _Mozilla_Thunderbird]Mozilla Thunderbird

0.89. IF you are using Mozilla Thunderbird as your email client:

0.89.1. Open the following document from the “Lease Refresh Process” article in the KB in Mozilla Thunderbird: ‘Initial_email_Thunderbird.eml’

0.89.2. Right-click anywhere in the message body and choose ‘Edit As New Message’

[image: ]

0.89.3. Update the signature if applicable.

0.89.4. Double-check all of the fields and content appears as expected (i.e. nothing has been obviously corrupted).

[image: ]

0.89.5. Click File -> Mail Merge

0.89.6. In the dialog box that appears select the following options:
· Source:		CSV
· Deliver Mode:	Send Later
· Format:		HTML
· File:		Lease_reconciliation_<leasenumber>.csv
· Character Set:	UTF-8
· Field Delimiter:	,
· Text Delimiter:	“

[image: ]

0.89.7. Click ‘OK’

All emails are now generated by the plugin, and sit in the Outbox ready for sending once confirmed.

0.89.8. Spot-check a few of the emails in the Outbox to ensure the volume and content is correct.

0.89.9. Send all emails via File -> Send Unsent Messages

[image: ]

0.89.10. Move to Tidy Up
[bookmark: _Microsoft_Outlook]Microsoft Outlook

0.90. ELSE IF using Microsoft Outlook:

0.90.1. Configure a second Outlook profile with the ‘Science IS Lease Admin’ as the primary email account.

0.90.2. Close Outlook and open using this new profile.

0.90.3. Open the following document from the “Lease Refresh Process” article in the KB in MS Word: ‘Initial_email_Outlook.docx’

0.90.4. Update the signature if applicable.

0.90.5. Click Mailings -> Start Mail Merge -> Step by Step Mail Merge Wizard
[image: ]

0.90.6. Select ‘E-mail messages’ in the Wizard that appears, and click ‘Next: Starting document”
[image: ]

0.90.7. Select ‘Use the current document’ and click ‘Next: Select Recipients’
[image: ]

0.90.8. Select ‘Use an existing list’ and click ‘Browse…’
[image: ]

0.90.9. Select Lease_reconciliation_<leasenumber>.csv

0.90.10. In the confirmation screen that appears, visually validate the mail merge has accepted the content of the .csv correctly by making sure all of the columns are present and appear to have the correct data, and click ‘OK’.

[image: ]

0.90.11. In the top menu bar, click ‘Highlight Merge Fields’.

This just helps highlight the parts of the message that will be changed on sending, and is useful for QA purposes.

0.90.12. Click ‘Next: Write your e-mail message’

0.90.13. As we are working from a template there is nothing to change here, so click ‘Next: Preview your e-mail message’



0.90.14. Use the arrow keys in the wizard to scroll through a few of the messages to check the content is correct.
[image: ]

0.90.15. When you are satisfied the content has been captured correctly, click ‘Next: Complete the merge’

0.90.16. Click ‘Electronic Mail’.
[image: ]

0.90.17. Update the ‘To:’ field to use the ‘ContactEmail’ column using the dropdown, and add the following text to the ‘Subject Line’:

Your computer is due for replacement. Your response needed

Leave all other options as default.
[image: ]

Note that unfortunately Microsoft’s mail merge function does not allow variables in the subject line, so we need to leave out ‘<<Department>>’.

0.90.18. Click ‘OK’ to send the emails.  Note there is no further confirmation screen and all emails will be sent when this button is pressed.

[bookmark: _Tidy_Up]Tidy Up
0.91. Close ‘Lease_reconciliation_<leasenumber>.csv’ if it is still open.

0.92. Manually send a modified version of the email to the users of multiple machines highlighted in Final Cleanup.  Update the following template from the “Lease Refresh Process” article in the KB as a base if it helps: ‘Initial_email_multiple.eml’

0.93. Set a personal reminder for the coming Friday, to send follow-up emails.

0.94. Open ‘Lease_reconciliation_<leasenumber>.xlsx’ and check the Science IS Lease Admin mailbox for auto-replies that were received in response to the mailout.

0.95. For each auto-reply:

0.95.1. Manually delete the invalid upi from the applicable row in ‘Lease_reconciliation_<leasenumber>.xlsx’

0.95.2. Attempt to source an alternative contact from:
· The content of the auto-reply (if any)
· The other contact fields in ‘Lease_reconciliation_<leasenumber>.xlsx’
· The ‘Notes’ and ‘CEA Comments’ fields

0.95.3. If an alternative contact is able to be found, manually email them using the above template, or the original email from your email client’s ‘Sent Items’ folder, as a base (modify as required).

0.96. Save and close ‘Lease_reconciliation_<leasenumber>.xlsx’

0.97. Update all ServiceNow Requests:
· Remove the old version of ‘Lease_reconciliation_<leasenumber>.xlsx’ and attach the latest copy
· Update the Customer Comments advising lease refresh reports have been generated and requirements sent to end users for review

0.98. Delete ‘Lease_reconciliation_<leasenumber>.csv’ (as no longer required) and any local copies of ‘Lease_reconciliation_<leasenumber>.xlsx’ (as masters are in the tickets).

0.99. Check where you are in the process (use the swimlane diagram or milestone document for reference) against the end of the lease schedule.  Are you on track?  If not, escalate to the Team Leaders to discuss.




End User
[bookmark: _Review_Department_Requirements][bookmark: _Toc422223300][bookmark: _Toc427829023]Provide Feedback

0.100. End users review emails, and respond advising replacement suitable, or requesting exception.


Lease Administrator
[bookmark: _Toc427829024][bookmark: _Toc422223301]Send Reminder

0.101. On the Friday following the initial mailout, open one of the ServiceNow requests and download ‘Lease_reconciliation_<leasenumber>.xlsx’.

For each field:

0.102. For those that have responded accepting the proposed replacement, update the ‘Result’ column to ‘Replace (standard)’.

0.103. For those that have requested an exception or a consultation:
0.103.1. Update the ‘Result’ column for that entry to ‘Replace (exception request)’
0.103.2. Delete the corresponding entry in ‘ProposedReplacement’.

0.104. For those that have provided feedback that no replacement is required (as able to return immediately, or that lease needs to be extended):
0.104.1. Update the ‘Result’ column for that entry to ‘Return without replacing’
0.104.2. Delete the corresponding entry in ‘ProposedReplacement’.
0.104.3. AND manually delete the entry in email address field.

0.105. For those that have not responded, update the ‘Result’ column to ‘No response’

0.106. Save ‘Lease_reconciliation_<leasenumber>.xlsx’.

0.107. Filter for ‘No response’ in the ‘Result’ column.
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0.108. Select all data (Ctrl+A) and copy/paste into a new Excel document.

0.109. If Excel throws the below prompt, click ‘OK’ (this is expected).
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0.110. Save As ‘<leasenumber>_followup.csv’ in format ‘.csv (MS-DOS format)’ accepting any prompts from Excel and close.

0.111. Also save ‘Lease_reconciliation_<leasenumber>.xlsx’ locally, and close the file.

Mozilla Thunderbird

0.112. IF you are using Mozilla Thunderbird as your email client:

0.112.1. Open the following document from the “Lease Refresh Process” article in the KB in Mozilla Thunderbird: ‘Reminder_email_Outlook.eml’

0.112.2. Generate emails to be sent out via Mail Merge per instructions above using ‘<leasenumber>_followup.csv’ for the content.

0.112.3. Spot-check a few of the emails in the Outbox to ensure the content is correct.

0.112.4. Send all emails via File -> Send Unsent Messages

0.112.5. Move to Tidy Up.

Microsoft Outlook

0.113. IF you are using Microsoft Outlook as your email client:

0.113.1. Close Outlook and reopen using the second profile you set up earlier.

0.113.2. Open the following document from the “Lease Refresh Process” article in the KB in MS Word: ‘Reminder_email_Outlook.docx’

0.113.3. Generate and send emails to be sent via mail merge per instructions above using ‘<leasenumber>_followup.csv’ for the content.

[bookmark: _Tidy_Up_1]Tidy Up

0.114. Close ‘<leasenumber>_followup.csv’.

0.115. Manually send a modified version of the email to the users of multiple machines highlighted in Final Cleanup

0.116. Set a personal reminder for the following Monday week to collate responses.

0.117. Update all ServiceNow Requests:
· Remove the old  version of ‘Lease_reconciliation_<leasenumber>.xlsx’ and attach the latest copy
· Update the Customer Comments advising a reminder has been sent to end users who have not yet responded.

0.118. Delete ‘<leasenumber>_followup.csv’ (as no longer required) and any local copies of ‘Lease_reconciliation_<leasenumber>.xlsx’ (as masters remain in the tickets).

[bookmark: _Toc427829025]Collate Responses

0.119. At the specified deadline, open one of the ServiceNow requests, and download ‘Lease_reconciliation_<leasenumber>.xlsx’.

0.120. In the ‘MASTER’ tab, update the column ‘Result?’ based on the responses received.

0.121. For those that have requested an exception or a consultation:
0.121.1. Update the ‘Result’ column for that entry to ‘Replace (exception request)’
0.121.2. Delete the corresponding entry in ‘ProposedReplacement’.
0.121.3. Save the email locally as a ‘Mail’ file (.eml extension in Thunderbird) or .msg file (in Outlook).

0.122. For those that have provided feedback that no replacement is required (as able to return immediately, or that lease needs to be extended):
0.122.1. Update the ‘Result’ column for that entry to ‘Return without replacing’
0.122.2. Delete the corresponding entry in ‘ProposedReplacement’.
0.122.3. AND manually delete the entry in email address field.

0.123. For those that still have not responded, update the ‘Result’ column to ‘No response’

0.124. If any responses are not purely an acceptance or exception request, respond/escalate as required.

0.125. For each row where ‘Result’ is ‘Replace (exception request)’, create a ServiceNow Work Task under the related parent Request, with the following details:
· Prioritisation:		Low (per default)
· Assignment Group:	Science IS/ITS Tamaki IT (as required)
· Assigned To:		Unassigned
· Short Description:		<Department> - Lease <lease number> - Exception request, consultation required - <Contact Name>
· Description:		<Contact name> has advised that our recommended lease replacement is not suitable for their requirements.  (Details in the attached email).  Please contact them directly to discuss their specific requirements, and agree on a suitable replacement.
This ticket may be closed when it has been updated with specific hardware requirements that will fill their needs, and a line outlining the justification.  This must be complete with 1 week from today.
· Attachment:		.eml/.msg file that you saved locally in the previous step

0.126. Set a personal reminder for 1 week to collate the results of the exception requests.

0.127. Still in the ‘MASTER’ tab, select all (Ctrl+A), and copy and paste values without changing location.
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0.128. Delete the following columns from the ‘MASTER’ tab:
·  ‘Orig. Purchase Price’ (E)
· ‘CEA Created By’ (K)
· ‘CEA Ordered For’ (L)
· ‘CEA Requested By’ (M)
· ‘CEA Comments’ (U)
· ‘ResponseDate’ (AA)
· ‘CEA No’ (AC)
· ‘CEA mismatch?’ (AD)
· ‘Serial in KAOS?’ (AE)
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0.129. Switch to the ‘Working’ tab, and Copy the first 6 rows (the ‘Key’)
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0.130. Right-click the first row of the ‘MASTER’ tab and click ‘Insert Copied Cells’[image: ]

0.131. Delete all tabs except for the ‘MASTER’ tab.
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0.132. Review the ‘Notes’ column, and manually delete anything that has no meaning to the current order.

0.133. Update all ServiceNow Requests:
· Remove the old  version of ‘Lease_reconciliation_<leasenumber>.xlsx’ and attach the latest copy

0.134. Check where you are in the process (use the swimlane diagram or milestone document for reference) against the end of the lease schedule.  Are you on track?  If not, escalate to the Team Leaders to discuss.

Process now moves to the next stage, ‘Generate Quote’ for all approved machines, and those for which no response was received.
When the reminder set above is triggered, execute the below steps.

Collate Exception Requests
0.135. Download a fresh copy of the applicable Asset Report, and populate the ‘Proposed Replacement’ field with the details specified by the Science IS Desktop Team in each of the resolved Work Tasks.

0.136. For each orange row for which we received a primary contact from Department Management:
0.136.1. Populate the ‘Custodian’ field with the upi of the user
0.136.2. Manually email them a confirmation email per above to get their feedback on our proposed replacement.

0.137. Save each updated Asset Report and attach back to the ticket.

0.138. Set a reminder for a further one week if there are still outstanding exception requests, or missing contact details.

Make sure to stay on top of the outstanding items and follow up regularly.  The Asset Reports are your record of where a lease is at, so it is critical these are kept up to date.

Now move to ‘Generate Quote’ for all of these exception requests, and proceed with the process from there.

Science IS Desktop Team
[bookmark: _Toc422223302][bookmark: _Toc427829026]Consult with End User

0.139. Assign the Work Task to self and reach out directly to the specified end user arranging a time to discuss their specific requirements.

Note this may not necessarily require new hardware, rather user education as to why the proposed replacement will fill their needs.

0.140. When agreement has been reached on the hardware requirements, Science IS Desktop Team updates the Work Task comments with these details and closes as Resolved.
[bookmark: _Toc422223303]

[bookmark: _Toc427829027]ORDER

Lease Administrator
[bookmark: _Generate_Quote][bookmark: _Toc422223304][bookmark: _Toc427829028]Generate Quote

This step may need to be repeated several times depending on how many exception requests there are (red rows), whether Department Management needs to assist in tracking down missing machines (and what their decisions are; orange rows) and whether they approve/decline the submitted quote at all.

0.141. For each cluster/area:
0.141.1. Download a copy of the Asset Report from the relevant ServiceNow Request

0.141.2. Filter the data by ‘Quoted?’ to only show ‘blank’ entries.  This makes the spreadsheet more readable by only showing those machines to be quoted, or that require further action/review (coloured rows).

[image: ] 

0.141.2.1. IF this is NOT the first time this is being performed for this lease, update the spreadsheet with any new information received (e.g. ‘Proposed Replacement’ for exception requests, ‘Notes’ for machines that are just to be returned).

0.141.3. Generate a separate quote per department for all confirmed replacements in the Asset Report via:
· Dell
i. Using the Lease Schedule Number as the E-Quote Name, and
ii. The associated ServiceNow Request number as the Description
· Cyclone (Apple)
· Other supplier if previously approved by Team Leaders.

0.141.4. Complete the ‘Price (ex. GST)’ column for each item quoted.

0.141.4.1. IF this is NOT the first time this is being performed for this lease, update the ‘Price Diff’ column manually.
0.141.4.2. ELSE this field updates automatically based on a formula.  Just review this column to make sure the data looks accurate.

0.141.5. Filter data by ‘Description’ and remove all ‘standard’ monitor models.
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While we are still quoting for replacement monitors, this reduces some of the ‘noise’ for GSMs/BOMs when they review the quotes.

0.141.6. Filter data by ‘Department’ to only show results for one area (refer to Appendix C – Cost Centres for details)
[image: ]

0.141.7. Save as <cluster/area>_lease<number>.xlsx (referred to as ‘Asset Report’ throughout the rest of this document).



0.142. For each cluster/area:
0.142.1. Open the relevant document per your email client from the “Lease Refresh Process” article in the KB:
· Quote_approval_Thunderbird.eml
· Quote_approval_Outlook.oft

0.142.2. Add/remove text in italics, and complete text bounded in <bold>.

0.142.3. Attach the completed Asset Report and quote(s) per department and send to the GSM/BOM, CC Accountant


0.143. For each item for which a replacement has been quoted, enter ‘Y’ in the ‘Quoted?’ column in the Asset Report.

0.144. Remove filters from ‘Description’ and ‘Quoted?’

0.145. Attach Asset Report back to ticket and update Customer Comments in associated ServiceNow Request advising what action has been taken and what the next step is to progress.

0.146. Set a personal reminder for 1 week from the current date.

0.146.1. When this reminder is triggered
0.146.1.1. Check to see if any further quotes need to be generated (exceptions, GSM/BOM feedback etc), and generate and send as required per above instructions

0.146.1.2. Check for any other updates that need to be made (e.g. received contact details, update exception to no need to replace) and process as required (e.g. propose replacement and send email manually).

0.146.1.3. Update Asset Reports as necessary and send as required.
(Accountants still need to know if any equipment has changed status and will no longer be replaced (e.g. returned no replacement/lease extension, so make sure you still send for these updates).

0.146.1.4. Re-set this reminder as many times as is required.
0.146.1.4.1. Keep the schedule end date in mind when re-setting this reminder, and escalate to Team Leaders if deadline is at risk for any machines
0.147. Check where you are in the process (use the swimlane diagram or milestone document for reference) against the end of the lease schedule.  Are you on track?  If not, escalate to the Team Leaders to discuss.

While the process moves on for those machines that have been quoted, this step is NOT complete until ALL rows in the Asset Report either have ‘Y’ entered in the ‘Quoted?’ column, or are coloured grey (indicating that no replacement is to be ordered).


Department Management
[bookmark: _Toc422223305][bookmark: _Toc427829029]Approve Quote

0.148. Review quotes, or delegate accordingly, and reply to all when approved.

0.148.1. IF there are any orange rows in the Asset Report (i.e. Science IS unable to locate machine/user) provide feedback as to location, next best point of contact or whether asset should be bought out.

0.148.2. IF quote is rejected for any reason, Department Management is to advise on the specifications/price to re-quote, and process loops back to Generate Quote.

0.149. For each item for which the quoted replacement was approved, Lease Administrator enters ‘Y’ in the ‘Quote Approved?’ column in the Asset Report and uploads back to the ticket.

While the process moves on for those machines that have been approved, this step is NOT complete until ALL rows in the Asset Report either have ‘Y’ entered in the ‘Quote Approved?’ column, or are coloured grey (indicating that no replacement is to be ordered).

0.150. Lease Administrator updates Customer Comments in associated ServiceNow Request advising what action has been taken and what the next step is to progress.


Faculty Finance (Accountant)
[bookmark: _Toc422223306][bookmark: _Toc427829030]Raise CEA

0.151. On receiving notice of GSM/BOM approval, open KAOS.

0.152. Generate a new CEA per quote following the instructions located at: http://kaos.wordpress.fos.auckland.ac.nz/kaos-manual/#CEA_Process with the additional requirements below:
· IT Justification/Comments MUST be completed specifying the lease refresh it pertains to.
· Documents:	Attach Asset Report(s)

0.153. Print CEA from KAOS using File -> Print

0.154. Send CEA and quotes to GSM/BOM for CEA signature, CC Lease Administrator.

0.155. Lease Administrator updates Customer Comments in associated ServiceNow Request advising what action has been taken and what the next step is to progress.


Department Management
[bookmark: _Toc422223307][bookmark: _Toc427829031]Approve CEA

0.156. Arrange for the required signatures and return to Faculty Finance (Accountant).

0.157. Faculty Finance (Accountant) sends to Business Analyst (Finance) to arrange Faculty Finance (Director)’s signature, CC Lease Administrator.

0.158. Lease Administrator updates Customer Comments in associated ServiceNow Request advising what action has been taken and what the next step is to progress.

0.159. Lease Administrator checks current progress of the process (using the swimlane diagram or milestone document for reference) against the end of the lease schedule.  If not schedule, escalates to the Team Leaders to discuss.


Faculty Finance (Director)
[bookmark: _Toc422223308][bookmark: _Toc427829032]Approve CEA

0.160. Approve and sign CEAs and send back to Business Analyst (Finance).

0.161. Business Analyst (Finance) assigns CEA numbers and adds to hard copy of CEAs.

0.162. Business Analyst (Finance) sends updated CEAs back to Faculty Finance (Accountant), CC Lease Administrator.

0.163. Faculty Finance (Accountant) sends to Central Finance (Director) for signature, CC Lease Administrator.

0.164. Lease Administrator updates Customer Comments in associated ServiceNow Request with CEA numbers, advising what action has been taken and what the next step is to progress.

0.165. Lease Administrator also updates CEA comments in KAOS with ServiceNow reference number.


Central Finance (Director)
[bookmark: _Toc422223309][bookmark: _Toc427829033]Approve CEA

0.166. Approve and sign CEAs and send back to Faculty Finance (Accountant), CC Lease Administrator.

0.167. Lease Administrator updates Customer Comments in associated ServiceNow Request advising what action has been taken and what the next step is to progress.

0.168. Lease Administrator checks current progress of the process (using the swimlane diagram or milestone document for reference) against the end of the lease schedule.  If not schedule, escalates to the Team Leaders to discuss.


Faculty Finance (Accountant)
[bookmark: _Send_Termination_Notice][bookmark: _Toc422223310][bookmark: _Toc427829034]Send Documentation to Leasing Company

0.169. If there are any machines that require extension or to be bought out, send notice to Leasing Company to advise.

0.170. Business Analyst (Finance) compiles all CEAs and sends to Leasing Company.

This Lease Refresh Process needs to be complete to this point between 120 and 60 days prior to the end of the current lease schedule.

The Leasing Company then invoices/extends existing assets as required, and adds the CEAs that have been raised for replacement to a new lease schedule.

While invoicing is the actual trigger for equipment to be added to leases by the lease company, if CEAs are submitted in the window above, then it helps ensure that invoices will be sent at the correct time.  This then helps ensure the replacing lease commences at the end of the finishing one, not in the quarter earlier (resulting in double-payment) and not in the following quarter (resulting in 6 months of equipment being bundled into one lease schedule).
Furthermore, if we ensure that the order is placed no later than 60 days prior to the end of a lease period, then it ensures we have enough time to deploy and return the existing equipment without incurring extension charges.

[bookmark: _Toc427829035]Generate Requisition

0.171. Generate a Purchase Requisition using Excel with purchase details and CEA number.

0.172. Update CEA in KAOS with:
· CEA number assigned
· Scanned copy of fully signed CEA

0.173. Send signed CEA and Purchase Requisition to STC to place order, CC Lease Administrator.

0.174. Lease Administrator updates Customer Comments in associated ServiceNow Request advising the CEA number, what action has been taken and what the next step is to progress.


STC
[bookmark: _Toc421196088][bookmark: _Toc422223312][bookmark: _Toc427829036]Raise Purchase Order

0.175. Raise the Purchase Order in PeopleSoft

This triggers an electronic request for approval being sent to either Faculty Finance (Accountant), Department Management, or Faculty Finance (Director) depending on the value.


Faculty Finance (Accountant)/Department Management/Faculty Finance (Director)
[bookmark: _Toc421196089][bookmark: _Toc422223313][bookmark: _Toc427829037]Approve Order

0.176. Approval is given by reviewing the order and clicking on the approval button in PeopleSoft.

0.177. Faculty Finance (Accountant) sends email to Lease Administrator to advise this has been completed.

0.178. Lease Administrator updates Customer Comments in associated ServiceNow Request advising what action has been taken and what the next step is to progress.


STC
[bookmark: _Toc421196090][bookmark: _Toc422223314][bookmark: _Toc427829038]Place Order

0.179. Place the order with the supplier.




Supplier
[bookmark: _Toc421196092][bookmark: _Toc422223315][bookmark: _Toc427829039]Acknowledge Order

0.180. Supplier sends email to STC with PO number to acknowledge order received.


STC
[bookmark: _Toc421196093][bookmark: _Toc422223316][bookmark: _Toc427829040]Notify Lease Admin et al with CEA & PO

0.181. Email the below list of people with order acknowledgement (which includes the PO number), and associated CEA number.
0. Faculty Finance (Accountant)
0. Lease Administrator
0. Desktop Team Lead
0. Science IS Manager

0.182. Lease Administrator updates Customer Comments in associated ServiceNow Request, with the Order number (last 6 digits of the PO number), advising what action has been taken and what the next step is to progress.

0.183. Lease Administrator checks current progress of the process (using the swimlane diagram or milestone document for reference) against the end of the lease schedule.  If not schedule, escalates to the Team Leaders to discuss.


Faculty Finance (Accountant)
[bookmark: _Toc422223317][bookmark: _Toc427829041]Create Order in KAOS

0.184. On receiving order acknowledgement from STC, open KAOS.

0.185. Generate a new Order from the Existing CEA per the instructions located at: http://kaos.wordpress.fos.auckland.ac.nz/kaos-manual/#Ordering_Process 


Supplier
[bookmark: _Toc421196095][bookmark: _Toc422223318][bookmark: _Toc427829042]Notify of Inbound Assets

0.186. IF Supplier is Dell, an email is sent from Dell to the Dell Reports Distribution List with all asset data in an attached spreadsheet (separate emails for PCs and monitors) prior to delivery. 



Lease Administrator
[bookmark: _Add_Asset_Details][bookmark: _Toc421196096][bookmark: _Toc422223319][bookmark: _Toc427829043]Add Asset Details to KAOS

0.187. On a daily basis, save any Dell asset report(s) that have been received locally.

If using Thunderbird for Mac, recommend installing the AttachmentExtractor add-on to automatically save attachments from emails on arrival to a local folder (and manually delete the folder contents periodically).  You can then use Mac’s powerful Spotlight search to easily search the files by content if need be.
Dell Computers
0.188. Open the PC asset report and perform a filter on the ‘PO Number’ column for all rows NOT containing ‘SC’
[image: ]

0.189. Delete all displayed rows.

0.190. Clear filters, and save and close the report.

0.191. In KAOS, go to Sections -> SIT -> Dell Asset Reports

[image: ]

0.192. Click ‘Import Dell Comp’

[image: ]

0.193. Point to the asset report you’ve saved.

0.194. Reorder the ‘Target Fields’ so they align with the corresponding ‘Source Fields’.  Some fields will be unused, this is expected.

0.195. Make sure ‘Add New Records’ is selected, and ‘Don’t import first record’ is checked.

[image: ]

0.196. Click ‘Import’

0.197. In the dialog box that appears, make sure ‘Perform auto-enter options while importing’ is checked and click ‘Import’.

0.198. A dialog box will be displayed indicating the success (or failure) of the operation.
[image: ]

Dell Monitors

0.199. Open the monitor asset report and delete the first (title) and last row (total) of spreadsheet.
[image: ]

0.200. Sort the data by the ‘PO Number’ column.

Each report contains data for more than one order, so the steps below need to be repeated for every unique order.

0.200.1. Delete all lines where the PO does NOT begin with ‘SC’, as well as any superfluous ‘SC’ lines.

In the example below, we will be importing Order 4230-123410 into KAOS so are deleting all other lines.
[image: ]

0.200.2. Save the file.

0.200.3. Open the Order in KAOS, click on the ‘Attractive Assets’ tab and click ‘Import’
[image: ]

0.200.4. Select the local copy of the Dell report that you have just created.

0.200.5. When prompted, select the primary worksheet tab.
[image: ]

0.200.6. Select only the ‘Asset Tag’ and ‘Monitor Serial No’ fields to import to ‘TagNo’ and ‘SerialNumber’ respectively, reordering the fields as required, checking all other options are as below.
[image: ]

0.200.7. Click ‘Import’.

0.200.8. Select ‘Perform auto-enter options while importing’ and click ‘Import’
[image: ]

0.200.9. Update the Description for each Attractive Asset that has been imported (copy/paste as required, following the naming convention previous instances of the same model).
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The data now exists in KAOS so that when the equipment arrives it can easily be added to the order, and then updated by support when deploying.


Supplier
[bookmark: _Toc421196097][bookmark: _Toc422223320][bookmark: _Toc427829044]Provision Order

0.201. Supplier sends hardware within their agreed timeframes.
[bookmark: _Toc422223321][bookmark: _Toc427829045]
RECEIVE

Note that where the destination location is Leigh or Tamaki, the following 3 major steps are performed by the Science IS Desktop Team in those locations, escalating to the Lease Administrator for assistance when required.

This section will likely occur multiple times for a single lease.

Lease Administrator
[bookmark: _Toc421196099][bookmark: _Toc422223322][bookmark: _Toc427829046]Receive & Reconcile Delivery

0.202. When equipment arrives, check the equipment on the packing slip matches what has been delivered.

0.203. Sign and date the front of the packing slip to indicate all items listed in the packing slip have been received.

0.204. Open the corresponding Order in KAOS

Dell Computers
0.205. IF the equipment that has arrived is Dell computers:

0.205.1. The computers should already have been created as assets in KAOS in Add Asset Details to KAOS.  
This can be validated by looking at the top of the ‘Financial Assets’ tab, where the number of ‘Dell asset reports’ should correspond with the number of items ordered.
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0.205.2. Click ‘Create Assets’ on the far left-hand side of the ‘Financial Assets’ tab
[image: ]

0.205.3. Check the box under ‘Create’ for each asset to be created.

0.205.4. Check ‘Use Dell Asset Data’

0.205.5. And select the corresponding type of asset using the drop-down under ‘Created Dell Asset Data’
[image: ]

0.205.6. Click ‘OK’

Apple/Other Equipment
0.206. ELSE:

0.206.1. Create a spreadsheet manually containing columns for the details of the assets you want to import (at minimum: Description, Serial, Asset Tag No)

0.206.2. Add the details from the received equipment to the spreadsheet you’ve created.

How this is achieved is up to you.  You may wish to make use of a barcode scanner for some of this, or if it’s one or two items only it may be just as easy to manually enter the details.

0.206.3. Assign an Asset Tag to each item based on those that are available in the stationery cupboard.

[image: ]

0.206.4. Click ‘Create Assets’ on the far left-hand side of the ‘Financial Assets’ tab
[image: ]

0.206.5. Check the box under ‘Create’ for each asset to be created.

0.206.6. And ‘Import from Spreadsheet’
[image: ]

0.206.7. When prompted, select the spreadsheet file you’ve just created.

0.206.8. Click ‘OK’

0.206.9. When prompted, select the primary worksheet tab.

[image: ]

0.206.10. Select only the relevant fields to import, reordering as required, checking all other options are as below.
[image: ]

0.206.11. Click ‘Import’.

0.206.12. Select ‘Perform auto-enter options while importing’ and click ‘Import’
[image: ]

0.206.13. Click OK at the ‘Import Summary’ dialog box.

[image: ]

0.206.14. You will be returned to the ‘Create Asset Records’ dialog.  Select the corresponding type of asset beside the asset you are adding, using the drop-down under ‘Created Dell Asset Data’.
[image: ]

0.206.15. Click ‘OK’.



0.207. Print the report of the equipment that has arrived, including asset tag and serial.

0.207.1. Put this report and the set of tags assigned (if non-Dell equipment) in the agreed storage location.

0.208. Put the receipted equipment in the storage area, following the below guidelines:
· Orders are stacked separately from one another
· The Order number is written in permanent marker filling an A4 piece of paper and stuck to the front/top of the Order for easy identification and access.

[bookmark: _Update_KAOS][bookmark: _Toc421196100][bookmark: _Toc422223323]

[bookmark: _Update_KAOS_1][bookmark: _Toc427829047]Update KAOS

0.209. Scan packing slips, add to the Order in KAOS for reference and file hard copies in folders beside photocopier.

0.210. IF the person performing this task is Onsite Support at Leigh or Tamaki, email a copy of the scanned packing slip to the Lease Administrator so they can commence process at Raise ServiceNow Work Tasks

0.211. Update Customer Comments in associated ServiceNow Request advising if delivery was partial or full order, what action has been taken and what the next step is to progress.

0.212. IF differences between order and delivery were noted in the previous step, process moves to Reconcile Delivery Differences

ELSE process moves to Raise ServiceNow Work Tasks.

0.213. Check where you are in the process (use the swimlane diagram or milestone document for reference) against the end of the lease schedule.  Are you on track?  If not, escalate to the Team Leaders to discuss.


[bookmark: _Reconcile_Delivery_Differences][bookmark: _Toc421196101][bookmark: _Toc422223324][bookmark: _Toc427829048]Reconcile Delivery Differences

Note: Lease Administrator may work together with Faculty Finance (Accountant) in order to resolve issues with order reconciliation.
This step (depending on the differences) may not hold up the rest of the process.

0.214. Email supplier highlighting the issue with the order and requests either:
0. Replacement (e.g. in the case of incorrect/faulty hardware)
0. Update (e.g. in the case of incorrect record of serial number)

0.215. Work together directly with the supplier to resolve the issue, keeping associated ServiceNow Request updated. 




[bookmark: _Toc422223325][bookmark: _Toc427829049]DEPLOY

Note that this section may occur at any time after receiving the delivery and can operate in parallel with asset deployment.

Faculty Finance (Accountant)
[bookmark: _Toc422223326][bookmark: _Toc427829050]Reconcile Acceptance Certificate

0.216. Receive the Acceptance Certificate from the leasing company, listing all assets to be paid, and the associated lease schedule number.

0.217. Check listed assets against the corresponding Orders in KAOS for those that have been received.

0.218. When all assets have been checked off, send to Business Analyst (Finance) for distribution to Faculty Finance (Director).


Faculty Finance (Director)
[bookmark: _Toc421196108][bookmark: _Toc422223327][bookmark: _Toc427829051]Approve Acceptance Certificate

0.219. Approve and sign Acceptance Certificate and send back to Business Analyst (Finance).

0.220. Business Analyst (Finance) sends back through to Faculty Finance (Accountant).


Faculty Finance (Accountant)
[bookmark: _Toc421196109][bookmark: _Toc422223328][bookmark: _Toc427829052]Return Acceptance Certificate to Lease Company

0.221. Email signed Acceptance Certificate back to leasing company so they can commence payment to supplier, and send hard copy via post.

[bookmark: _Toc422223329][bookmark: _Toc427829053]Update KAOS

0.222. Scan a copy of the Acceptance Certificate and adds the scan as an attachment to ALL of the Orders under the Acceptance Certificate.

[image: ]

0.223. Update the affected CEAs and Orders with the listed Schedule Number in KAOS.

[bookmark: _Toc293821607]Lease Administrator
[bookmark: _Raise_SN_Request][bookmark: _Raise_Service-Now_Request][bookmark: _Raise_Service-Now_Work][bookmark: _Raise_ServiceNow_Work][bookmark: _Toc422223330][bookmark: _Toc427829054]Raise ServiceNow Work Tasks

Note that Work Tasks are to be created by the Lease Administrator for Tamaki/Leigh as required also (consider them ‘Departments’ for this purpose).  This is dependent on support staff in those locations notifying that the equipment has arrived (as described in Update KAOS).

0.224. (On the first occasion this instruction is executed only) Create a single Work Task with the following details
· Prioritisation:		Low (per default)
· Assignment Group:		Science IS
· Assigned To:		Unassigned
· Short Description:		<Cluster/area> - Lease <lease number> - Retrieve non-replaced equipment
· Description:		Please collect the following equipment and prepare for return.
<List of asset tags and Custodians for equipment that has been flagged as not requiring replacement and requires retrieval (coloured grey in the Asset Report).>

0.225. Download the related Asset Report from the ServiceNow Request for the arrived assets, and add an additional column to the end: ‘Arrived?’

0.226. For every asset (or group of assets e.g. laptop + docking station, PC + monitors + peripherals) that has arrived, update this field to ‘Y’.

0.227. Attach the updated Asset Report spreadsheet back to the Request.

0.228. Verify the department that the equipment is for by checking the PO/Order number on the equipment against the Order number in KAOS.

0.229. Check to see if a Work Task for deployment has already been created by opening the relevant tracking Request (that was created in Raise ServiceNow Request per Cluster).

0.230. IF a Work Task does already exist, update the Customer Comments advising that a new delivery has arrived and give a summary of the contents (e.g. ‘3x Optiplex 9020SFF standard spec’).

0.231. ELSE if no Work Task exists, create a Work Task under the tracking Request, entering the details below:
· Prioritisation:		Low (per default)
· Assignment Group:		Science IS
· Assigned To:		Unassigned
· Short Description:		<Department> - Lease <lease number> - Deployment
· Description:		Please see below a list of assets to deploy for <Department>.  Make sure original equipment is returned, wiped and stacked for return per normal process.
This ticket may be closed when ALL new computers have been deployed, old equipment retrieved, wiped and packaged ready for return.
If part of an order is yet to arrive, hold the ticket open until it does and you can deploy OR assign to Team Leader for administration.

<Copy/paste the relevant rows from the tracking spreadsheet to the description, tidying formatting as required>


Science IS Desktop Team/End User
[bookmark: _Toc422223331][bookmark: _Toc427829055]Confirm End-User Desktop Config

0.232. Science IS Desktop Team assigns the Work Task to self and reaches out directly to the specified end user advising that their machine needs replacement and requesting their specific build requirements and schedule.

0.233. Liaises with end user to define their requirements.


[bookmark: _Toc422223332]Science IS Desktop Team
[bookmark: _Toc427829056]Build Machine

0.234. Unbox machines and ensure it is in good condition.

Note that hardware quality checks are performed inherently as part of the build, and any issues need to be flagged with the Lease Administrator directly and dealt with on an ad hoc basis.

0.235. Apply UoA asset tag(s) to hardware if required (sourcing from list stuck to order).

0.236. Build machine per established process to the end user’s requirements.

0.237. Arrange for electrical testing of the machine to be performed by Metrotest prior to deployment.
Note this is a BLOCK and the deployment CANNOT proceed until electrical testing is completed.

[bookmark: _Toc422223333][bookmark: _Toc427829057]Deploy & Test Machine

0.238. Install new machine at the time arranged with the user, and remove the old machine.

If there are any hardware issues with the machine to be returned (physical damage, missing peripherals) the department is responsible at this point and any charges will be passed on accordingly.

0.239. Perform a quick test during deployment to ensure machine is running as expected on install.

0.240. Ask end user to confirm all works as expected prior to moving forward in the process.

0.241. Update the Custodian field in KAOS for each of the assets assigned.

0.242. Hold the returned machine for a period of 1 week before proceeding.

[bookmark: _Toc421196110][bookmark: _Toc422223334][bookmark: _Toc427829058]Remove/Clean Machine Image

0.243. Wipe all data from returned machine using standard Science IS process.

0.244. Follow the regular Science IS teardown process as normal (tidying up Active Directory, KeyServer, SCCM as required).

0.245. Prepare the machine and any required peripherals ready for return and put in the agreed location for lease returns.

0.246. Update the ‘Status’ field in KAOS for each asset to ‘Ready for Return’, and delete the entry for ‘Custodian’.

0.247. Resolve the ServiceNow Work Task that was created for deployment.


Science IS Desktop Team/Lease Administrator
[bookmark: _Toc421196111][bookmark: _Toc422223335][bookmark: _Toc427829059]Coordinate Pickup with Lease Company

Note: Depending on the area, Science IS Desktop Team may work together with Lease Administrator to coordinate the pickup of equipment.
· Leigh – Onsite
· Tamaki – Onsite
· Lease Administrator – All others

0.248. When there are sufficient machines to justify a pickup (doesn’t need to be for the whole lease, but also not a lot of small pickups) complete and print a Computer Collection Receipt along with a list of assets to be returned.

· You can either use the template from the intranet, or the template that has been set up below.
· Use the information from ‘OCM_<leasenumber>.xls’ that you saved way back in Prepare Quarterly Reports to fill in the fields that the leasing company requires.



0.249. Send an email to the leasing company advising of return and requesting pickup.

0.250. Courier picks up machines as requested.

0.250.1. Be aware of the timeframe here, and make sure the courier makes the pickup in a timely fashion.  We don’t want to miss a return date simply because we didn’t follow up the courier.

0.251. Download the Asset Report from the relevant ServiceNow Request, and add an additional column to the end: ‘Returned?’

0.252. For every asset (or group of assets e.g. laptop + docking station, PC + monitors + peripherals) that is returned, update this field to ‘Y’.

0.253. Update the ServiceNow Request:
· Remove the old version of the Asset Report and attach the latest copy
· Update the Customer Comments advising some equipment off the Asset Report has been returned to the leasing company.

0.254. Check where you are in the process (use the swimlane diagram or milestone document for reference) against the end of the lease schedule.  Are you on track?  If not, escalate to the Team Leaders to discuss.



Lease Administrator
[bookmark: _Toc421196112][bookmark: _Toc422223336][bookmark: _Toc427829060]Update ServiceNow & KAOS

0.255. For each machine that is picked up, update the asset status in KAOS to ‘Lease Return’.

0.256. When ALL Work Tasks for a parent Request are closed, and the ‘Returned?’ field for ALL assets in the Asset Report is set to Y, email a copy of the final Asset Report to Faculty Finance (Accountant), CC GSM/BOM with below text:
Subject: Lease <number> - Complete

Dear <name>

Please find attached the final Asset Report for Lease <number>.

All machines have now been refreshed and otherwise accounted for, details can be found in the attached spreadsheet.

Ref: <ServiceNow ticket number>

Regards,

<name>
















0.257. Now close the parent Request, and the Lease Refresh process is complete.






[bookmark: _Toc422223337][bookmark: _Toc427829061]Appendix

[bookmark: _Appendix_A_–][bookmark: _Toc422223342][bookmark: _Toc427829062]Appendix A – Standard Hardware

Hardware for the university is reviewed by faculty management on an annual basis, and standard hardware builds agreed.

When proposing replacements, the rules we follow are:
1. Match model to model following the table below
	Current Model
	Proposed Replacement
	Notes

	Optiplex 990SFF
	Optiplex 9020SFF
	

	Optiplex 990MT
	Optiplex 9020MT
	

	Optiplex 9010AIO
	Optiplex 9030AIO
	

	Latitude E6320
	Latitude E7250, 12.5”,
	256GB SSD

	Latitude E6420
	Latitude E7450, 14”,
	500GB Hybrid

	
	Latitude E6440, 14”,
	When graphics card upgrade required

	Latitude E6520
	Latitude E5550, 15”,
	500GB Hybrid



2. Within this, if the ‘old’ computer’s configuration is less than or equal to the University standard published on the intranet, then this standard is proposed as the replacement

3. If any config item on the current model is ‘better’ than the University standard, match the config in the proposed replacement (or better if not available) for this config item only, following rule #2 for the rest of the config items

4. For laptops, make sure screen size is included in the proposed replacement

5. In the case of Apple equipment, match the proposed replacement to the bundle that has the closest configuration to the ‘old’ computer from cyclone.co.nz



[bookmark: _Appendix_B_–][bookmark: _Toc422223343][bookmark: _Toc427829063]Appendix B – Owners & Escalations
Process Owner – Lease Administrator
The overall process owner is the Lease Administrator.  They are responsible for initiation, and timely completion of the process.  If there is any lack of clarity about where in the process a particular lease refresh is and whose is the next action, the Lease Administrator should be able to provide this information.
Section Owners
At a lower level, there are also ‘Section Owners’ within the process, who have the responsibility of at least being aware of progress, while not necessarily taking action themselves, when the process hits their section.  For simplicities sake, there are only two ‘Section Owners’:
· Lease Administrator – from initiation to quote generation
· Faculty Finance (Accountant) – from quote approval to order acknowledgement
· Lease Administrator – from order acknowledgement to completion
Escalation Points
· The first point of enquiry should always be the Section Owner.
· If they are not able to assist, the Lease Administrator (as the Process Owner) is the next escalation point.
· If they are not able to assist or further escalation is necessary, the Science IS Team Leaders are the final point of escalation.

[bookmark: _Appendix_C_–][bookmark: _Toc422223344][bookmark: _Toc427829064]Appendix C – Cost Centres

	Dept
	Description
	Cluster/Area
	Approval
	Accountant

	4000
	Science Faculty Office
	Faculty Office/Other
	Anita Lai

	4003
	Science Faculty Centre
	
	

	4045
	Centre 4 Genomics & Proteomics
	
	

	4194
	Fac of Sci Technical Services
	
	

	4230
	Science IS
	
	

	4231
	Finance
	
	

	4232
	Operations Admin
	
	

	4233
	Student and Academic Services
	
	

	4234
	Student Dev & Engagement
	
	

	4235
	Group Services
	
	

	4236
	Facilities and Services
	
	

	4237
	Communications and Marketing
	
	

	9431
	Maurice Wilkins Centre
	
	

	9766
	E-Research
	
	

	9159
	M Wilkins Ctre - Molec Biodisc
	
	

	4020
	SBS Salary / Income
	SBS, Psych
	Cathy Comber
	Ireen Lata

	4320
	Psychology - Administration
	
	
	

	4110
	Institute of Marine Science
	Leigh Marine
	Arthur Cozens
	Ireen Lata

	4111
	Marine Sci. Interpretive Ctr
	
	
	

	4060
	Chemical Sciences General
	Environ, SCS, Phys
	Lynda Pitcaithly
	Rene Tablizo

	4140
	Environment
	
	
	

	4300
	Physics - Administration
	
	
	

	4220
	Computer Science
	Math, Stats, Comsci
	Karren Maltseva
	Vivian Nayon

	4240
	Mathematics Administration
	
	
	

	4260
	Statistics Administration
	
	
	

	4265
	Stats Consultancy Services
	
	
	

	4368
	Sport Science - Tamaki
	Tamaki
	Bruce Rattray
	Vivian Nayon
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		Computer Collection Receipt



		From: 		University of Auckland



		Department / Faculty:		Science Faculty



		Collection Location:		Old Choral Hall B01 carpark entrance



				University of Auckland



		Date / Time for pickup:



		Contact: 		Haiying Tan



		Contact Phone no.

				 

		Lease Schedule No:   





		Equipment Type				Units				Cartons 



		Desktops				0



		Monitors				0



		Notebooks				0



		Carry case



		Extra Mice



		Docking Station



		Laptop stand

		Extra Keyboard

		TOTALS				0				0



		The University of Auckland despatch name:		Haiying				NZCS Driver's name:



		The University of Auckland despatch Signature:						NZCS Driver's signature:







		Note: 
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